
Chem/MatS/ChEn 4223W Tuesday, February 5/Thursday, February 7- 
 Tuesday, February 12/Thursday, February 14 
 

Lab 2 
Statistical Copolymers via Free-Radical Copolymerization 

Report Due: In Lecture, Monday, February 25 
Report Revision Due: In Lecture, Monday, March 11 

 
 
 
Introduction 
 
Copolymerization of multiple monomers allows for the synthesis of new polymeric materials 
with properties that are often substantially different from homopolymers made from the 
individual monomers.  This experiment will allow you to perform the radical copolymerization 
of styrene and methylmethacrylate and determine the relative reactivities of these monomers in 
this process. As in Lab 1, polymerizations will be initiated via the thermal decomposition of 
benzoyl peroxide to benzoyl radicals. You will also learn to characterize polymers by nuclear 
magnetic resonance (NMR) spectroscopy. 
 
As early as the 1930’s it was recognized that in the polymerization of equimolar mixtures of two 
different monomers, the tendencies of the monomers to incorporate into the growing chain will 
differ.  The result of the variable incorporation of monomer is that the composition of the feed 
(and thus the copolymer) will change as the polymerization proceeds.  Variable monomer 
incorporation arises from selectivity of monomer addition at the growing chain end. The 
copolymerization of monomers M1 and M2 can give rise to four different propagation 
opportunities (Figure 2-1): 
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Figure 2-1. 
 
Here, k11 and k22 are the rate constants for self-propagation, and k12 and k21 are the rate constants 
for cross-propagation.  The relative reactivity ratios for M1 and M2 in this polymerization can be 
described as r1 = (k11/k12) and r2 = (k22/k21), respectively.    
 
The rate of consumption of M1 initially can be described by: 
 



(2.1) ]M][M[]M][M[
]M[

21211111
1  kk

dt

d
 

 

And of M2: 
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The consumption of M1 and M2 is due to their incorporation into the growing copolymer.  By 
writing the equation above as a ratio of rates for the two monomers, and by applying the steady 
state approximation, a ratio of monomer incorporation into the copolymer can be expressed as 
the instantaneous copolymerization equation: 
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If the monomer feed concentrations of M1 and M2 (mole fractions) are denoted f1 and f2, and the 
mole fraction of these monomers that are incorporated into the copolymer as F1 and F2, the 
instantaneous copolymerization equation can be defined for F1: 
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Experimentally, reactivity ratios are often determined by performing a series of polymerizations 
under identical experimental conditions, but beginning each polymerization at different 
concentrations of the two monomers.  The polymerizations are terminated at low conversion (3-
10%), and the resulting polymer is characterized to determine the levels of incorporation of the 
two monomers (F1 and F2).  
 
A variety of methods have been devised for extracting r1 and r2 from copolymer feed (fn) and 
composition (Fn) data. In the days before computerized data analysis, Fineman and Ross1 and 
Kelen and Tudos2 developed forced linearization methods for dealing with the complexity of 
equation 2.4. Today, non-linear least-squares curve-fitting programs (such as Kaleidagraph) 
allow for the determination of r1 and r2 without resorting to a forced linearization protocol.3 
Values for r1 and r2 can be obtained by a form of the instantaneous copolymerization equation 
given in terms of f1 and F1 by substituting (1 - f1) for f2 in equation 2.4: 
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1 Fineman, M.; Ross, S.D. J. Polym. Sci., 1950, 5, 259. 
2 Kelen, T.; Tüdös, F. J. Macromol. Sci.-Chem., 1975, A9, 1. 
3 For a more detailed discussion, including references on how to implement this fit, see: (a) Bauduin, G.; Boutevin, 
B.; Belbachir, M.; Meghabar, R. Macromolecules 1995, 28, 1750, and references therein. (b) G. Odian, Principles of 
Polymerization, pp. 467-470. 



 
In this case, the data of a plot of f1 vs. F1 can be analytically fit to equation 2.5 to obtain values 
for r1 and r2. 
 
 
Experimental 
 
Bulk copolymerization of styrene and n-butylmethacrylate (Feb 5/7) 
 
The goal of this experiment is to observe the consequence of copolymer ratio on the physical 
properties of a copolymer material. 
 
 In a 6” test tube, pour a total of 5 mL of styrene and n-butylmethacrylate; feel free to choose 

any ratio of the two monomers, though styrene content between 5 and 25 wt% will give you a 
nice spectrum of plastic flexibility. Add 0.05 g of benzoyl peroxide, and swirl to dissolve. 
Follow the instructions in Lab 1 for spraying an aluminum pan with silicone mold release 
and polymerizing the mixture in the 70 °C oven. 

 Next week: Remove your polymerized sample from the aluminum pan. How does this sample 
compare with the homopolymers from Lab 1? 

 
Copolymerization of styrene and methylmethacrylate (Feb 5/7) 
 
The goal of this experiment is to copolymerize styrene and methyl methacrylate using a free 
radical initiator, and determine reactivity ratios for the resulting copolymers. 
 
 In three separate 20-mL scintillation vials, put 5 mL (total) of a styrene-methyl methacrylate 

monomer mixture.  For best accuracy, we recommend that you use balances in the hoods to 
measure reagent masses rather than working with reagent volumes. Use the ratios of styrene 
to methylmethacrylate that were listed in your pre-lab handout. Add 0.1 g of benzoyl 
peroxide to each of the tubes and swirl to dissolve.  Repeat the procedure outlined for the 
styrene polymerization performed in Lab 1.  Make sure to record the polymerization time and 
temperature, and dry your product in the vacuum oven as you did with the styrene 
homopolymer. 

 
NMR analysis of copolymer ratios (Feb 12/14) 
 
 Determine the mass yield of your samples. If the yield is greater than 10%, or you isolate less 

than 50 mg of polymer (about 1%), you should disregard the data from that polymerization 
run. 

 Check out three NMR tubes from the stockroom. Put approximately 25 mg of each of your 
polymer samples into a small vial along with about 1 mL of CDCl3 to dissolve, and allow to 
sit for about 30 minutes to fully dissolve. Then, transfer each solution to an NMR tube. 
CDCl3 is very expensive, so don’t spill or waste it. Put your samples in the class NMR tube 
rack according to the TA’s instructions, and label each tube with your group number and the 



fraction of styrene (fstyrene) monomer you used. (For those of you familiar with taking NMR 
spectra of organic samples, 25 mg will seem like too much material. However, because peaks 
in NMR spectra of polymers tend to be broad, you’ll need more than you’re used to.) 

 
Your NMR spectra for this class will be acquired by the TA’s in the Chemistry Department 
NMR Facility, but you will be expected to work up the data yourself. Raw FID’s will be 
available for processing in the data directories of the Polymer Lab NMR account. Each FID file 
will be titled according to the date and time it was acquired; a listing of which files are yours will 
be posted on the “Data” page of the course website. 
 
You’ll be working up your NMR data using ACDLabs’ NMR Processor for PC. Instructions on 
how to use this program are in Appendix A. 
 
You should use the integrations you performed on the NMR spectra to determine F1 and F2 for 
your copolymer samples. Remember to factor in the number of protons that contribute to each 
NMR peak(s) per molecule. As part of an Assignment, you will be expected to post your data to 
the course WebCT Discussion Board. 
 

Lab Report (due in lecture, Monday, February 25) 
 
Prepare a lab report titled, “Determination of reactivity ratios in the free radical polymerization 
of styrene and methylmethacrylate.” Using nonlinear least-squares fitting to Equation 2.5, 
calculate r1 and r2 from the class’ f1 and F1 data for the copolymerization of styrene and 
methylmethacrylate. You can use Kaleidagraph, a program available in the Microcomputer Lab, 
to do this; or, you can use any program capable of non-linear least-squares fitting. Instructions on 
how to use Kaleidagraph are in Appendix B at the end of this handout. 
 
The report should be single-spaced, and any figures, tables or graphs should be inserted in the 
text. Your report should be structured like a journal article in an American Chemical Society 
journal (such as Macromolecules), like the one you examined as part of Assignment 4. As you 
did in that assignment, you may want to consult websites or articles on how to write a scientific 
paper. 
 
Please be concise in your writing. Be sure to list the names of all of your group members as 
coauthors; as the corresponding author, your name should be designated with a *. At any point, if 
you wonder how to structure or phrase something, look at a couple of Macromolecules papers 
and copy their format. 
 
Overall, your report should stand on its own, independent of this course. If a reader from another 
university with no knowledge of your assignment were to read your report, would they 
understand it? If not, you need to explain better. Explain your purpose. Explain your graph. 
Explain your conclusions. 
 
Your report should contain the following sections: 
 



Introduction. Discuss the goals of your kinetic analysis. Give background on copolymer kinetic 
analysis here, including a brief discussion of the fitting technique you plan to use. Other than to 
satisfy the requirements of this class, what was the aim of this experiment? (Why would anyone 
want to know reactivity ratios?) Give a background for the experiment by (1) discussing any 
theoretical issues required to understand the lab and (2) describing why the experiment might be 
important. If you write about something you learned from somewhere else, reference your 
source; however, as in journal articles, reference materials that a reader can access (e.g., other 
journal articles, textbooks, handbooks) rather than materials that others don’t have access to 
(e.g., my lectures, your lab instructions). Chemical structures of your molecules, if you would 
like to include them, can go here as well. 
 
It will be tempting for you to copy the Introduction of the lab instructions into the Introduction of 
your manuscript. They serve different purposes, and your Introduction should be more concise 
and general than mine anyway. So don’t do this. 
 
Experimental. How did you do the experiment? Your description should allow someone who has 
never met you or read the assignment to reproduce your work. Omit parts that don’t help this 
imaginary person. (Example: “The aluminum pan was labeled with our names.” Your imaginary 
experimenter will probably succeed if he labels the pan something else.) But include parts that 
might be important. (Example: “The sample was placed in an aluminum pan and dried in a 
vacuum oven for 2 days.” What if the experimenter used something else other than aluminum? 
Heat might not transfer as well, flat shape might be important to effective curing….) As in the 
Experimental sections of ACS journal articles, your Experimental should be written in the third 
person past-tense. 
 
Be as numerical as you can be here. Always report precisely what you did (“0.05 g (0.2 mmol) 
benzoyl peroxide was added”) rather than what you calculated (“one molar equivalent of benzoyl 
peroxide was added”). In addition, be descriptive about what happened in lab. If your reaction 
turned blue, write that. If you departed from the written procedure, write that. It may be tempting 
for you to edit my lab instructions directly into your experimental; because my instructions 
include details that are helpful, but not really critical, you should resist this temptation and write 
your experimental from your lab notebook in your own words. 
 
Results and Discussion. What were the results of your experiments? What did they demonstrate? 
Was your hypothesis proven? In this section, you should include: 
 

 A discussion of what you did and what data you (and the class) collected. 
 Any equations you need to explain your analyses. 
 An example NMR spectrum with integrations, illustrating how you determined f values. 
 The appropriate graph for determining r1 and r2, (be sure to include a figure caption). 
 The calculated values of r1 and r2. 
 A one-paragraph discussion of your results with a comparison to literature values. What 

are the sources of the error you estimated? 
 
I have asked for the Results and Discussion sections together because Macromolecules does. 
This means you should present your data and discuss it at the same time. Figures should have 



Figure Captions that describe the Figure and explain any peculiar notation. (If you are using 
Microsoft Word, you can format these automatically by selecting your Figure, and then choosing 
Insert -> Reference -> Caption.) If there are any sources of error that would explain why your 
data doesn’t work the way you expected, you should include that here. 
 
References. You may format your references as either footnotes or endnotes. In either case, the 
in-text reference number should be a superscript number. Make sure references are in ACS 
format: (Authors Journal, Year, Volume, Page) for journal articles; see the ACS Style Guide for 
other sources such as books. 
 
Some resources on what the different sections of a research paper should look like are listed on 
the course website, on the “Links” webpage. A few tips: 
 
 You will want to become familiar with Equation Editor (included in Microsoft Word) or 

another equation formatting tool (such as MathType Lite, free on the web) for your reports. 
It's pretty difficult to format complex equations on one line, and copying equations from my 
lab instructions won't format very well in your document. Help with these tools is available 
in Word or on the web. 

 Same is true for ChemDraw or ISISDraw. The latter is a free download. 

 Same is true for subscripts and superscripts. Most programs have a "Format" -> "Font" type 
option that will allow you to do these formats. 

 Variables, and most constants, are italicized. Look at a textbook, or the ACS Style Guide, if 
you are unsure about whether to italicize something. 

 Numbers and units are always separated by a space. ("10 mL" rather than "10mL".) So are 
math functions. ("r = 1", not "r=1".) 

 Units of measure in ACS publications are always abbreviated. Some of these abbreviations 
you will feel comfortable using. (Like “mL” for milliliters.) Others you won’t be. (Like 
“min” for minutes.) However you feel about it, abbreviate all units of measure. 

 Your Experimental should be very specific. Don't make your reader calculate anything; say 
exactly how much of things you used, how you interpreted data, and make sure significant 
figures are roughly correct. ("Five milliliters" means EXACTLY five milliliters. "5 mL" 
means 5 +/- 1 mL, and I think you can measure more accurately than that. "5.0 mL" would 
probably be appropriate.) 

 Do not reference my lab instructions. You will find everything that is in them in textbooks 
and in the papers I cite. Read, and then reference, these instead. 

Revised Lab Report (due in lecture, Monday, March 11) 
 
You will have the opportunity to revise your report after we grade it the first time. You will be 
able to recover up to half of the maximum points for the lab report. (So if you received 70/100 on 
the first grade, your revision could net you 100/100; but if you received 40/100, your revision 
could earn you a maximum of 90/100.) If you lost points because you turned in your report late, 
you will not be able to recover those points in the rewrite. We will hand back your report in class 



on March 4, with suggestions on how to improve your report. This list may not be exhaustive; if 
I don’t circle every instance of an error, that doesn’t mean I don’t expect you to correct every 
instance of an error. You are particular encouraged to meet with Andy Taton in his office (Smith 
425) after lab to talk specifically about what you might improve in this report. 



Chem/MatS/ChEn 4223W 
 

Lab 2 Appendix A 
Processing NMR Data with ACD/NMR Processor 

 
 
It is possible to process and print NMR data in the NMR facility, but it is usually easier to work 
up data on your own computer, or on the computers in the Microcomputer Lab (101D Smith). In 
addition, when you analyze NMR data on your computer it is easier to cut and paste the spectra 
into your lab reports. To do this, you will need two pieces of software: 
 
 A client program to transfer (via FTP) your NMR data from the NMR server. There are a lot 

of these out there. PC users can download WinSCP (http://winscp.net/) or FileZilla 
(http://filezilla-project.org/, also available on Microcomputer Lab workstations) for free. Mac 
users can also download FileZilla or Cyberduck (http://cyberduck.ch/) for free. These 
instructions will describe WinSCP (the program available in the Microcomputer Lab), but the 
other programs work very similarly. 

 
 A program to Fourier transform the data and analyze the resulting spectrum. There are only a 

few of these. For PC users, ACDLabs has recently made ACD/NMR Processor free to all 
academic users, and this software will be described in these instructions. Browse to 
http://www.acdlabs.com/resources/freeware/nmr_proc/index.php to install the software on 
your own computer, or you may also use it pre-installed in the Microcomputer Lab (101D 
Smith). Mac users can look into iNMR (www.inmr.net). I think this program can do 
everything that you need for this course. The full version of the software costs money, but the 
trial version is free and appears to work the same as the full version except for occasional 
reminders to upgrade (which don’t seem to stop you from using the software anyway). The 
program works much like ACD/NMR Processor, so you can use these instructions as a 
general guide to that software, but I won’t be describing it explicitly (mainly because I’ve 
never used it). 

 
Transferring NMR data via FTP 
 
You will need to transfer the .fid folder from the NMR lab server to your personal computer 
using an FTP program such as FileZilla or WinSCP. If you use WinSCP: 
 
 Make sure you are on-campus, or that you are using VPN tunnel software 

(http://www.oit.umn.edu/vpn/). 

 Open WinSCP, and click New to create a new connection. 

 In the next window, enter 
o Host name: echo.chem.umn.edu 
o User name: zzzlab 
o Password: zzzlab’s password 
o File protocol: FTP 



 Press Login to connect to the server. (You can also click Save to create a profile with these 
settings.) 

 On login, the program will show the remote server’s directory structure on the right, and your 
local computer’s directory on the left. Find your .fid subdirectory, and click-and-drag to copy 
that subdirectory to your local machine. The subdirectory will contain files titled fid.dat, 
log.dat, procpar.dat, and text.dat; you will need them all, so just copy the directory that 
contains them. 

 
Analyzing NMR data with ACD/NMR Processor 
 
 

 
 
 

1. Start the 1D NMR Processor program, choose to Open an Existing File, click More Files…, 
and browse to find your fid.dat file. (Make sure the File Type dropdown box lists “All Files 
(*.*)” so you can see it.) 
 

2. The program window will show the FID: 
 



 
 
 From here you have a couple of options. If you pick the “Shortcut” button above the FID, the 

program will attempt to do all of the spectral analysis for you—pick peaks, find multiplets, 
calculate coupling constants, etc. Most of the time it will fail, either because peaks from 
impurities make it over-assign the spectrum, or because it attempts to classify obviously 
overlapping multiplets as single resonances. I think you will find that you are much more 
successful at it on your own. 

 
 So, instead, I recommend that you analyze your spectrum yourself. Click Fourier 

Transform to convert your FID into a 1D NMR spectrum. The program will do a few things 
automatically for you; it will automatically apply a phase correction, a baseline correction, 
and an apodization (window) function to your spectrum. In general, the software does an 
excellent job of all of these things, and you may never need to change the software’s choices 
for these. But in case you do: 

 
 Use the zoom buttons, and particularly the Horizontal 

Zoom button, to focus in on an area of the spectrum that 
shows some structure. Click and drag to zoom in. If you 
want to zoom back out, click the Show Whole Spectrum 
button. If you have a wheel mouse, the wheel in the center 
can be used to control the vertical zoom independently of 
the horizontal zoom. 
 



 

 
 

 Click Phase to modify the software’s auto-phasing. There are two phase corrections 
applied, a zero-order (Ph0) and first-order (Ph1) one. The easiest way to see how this 
affects your spectrum is to select the Mouse Phase option in the command bar; in a two-
button mouse, the left button controls Ph0, and the right button a combination of Ph0 and 
Ph1. If you don’t like what you’ve done to the spectrum, you can always back out of the 
phasing menu by clicking the red X, or go all the way back the beginning with File → 
Reopen. 

 Click Baseline to set baseline points; this can occasionally be useful for quantitative 
integration, but you probably won’t ever need it. 

 Click Interactive FT (or WFunctions or Apodization when the FID is showing) to 
perform resolution enhancement. Noise in the early and/or late part of the FID results in 
broadening of peaks in the Fourier-transformed spectrum, and so sometimes it is useful to 
multiply the FID by a “window” function to fix this problem. 



 
 before apodization after apodization 

 

      
 

 In the Interactive FT window, you can perform “resolution enhancement” by switching 
the Window Function entries from Default to User, and then adjusting the given values 
for EM (exponential function) or GM (Gaussian function). 

 
3. Back in the main spectrum window, click on Reference to make sure the chemical shift scale 

is correctly referenced to CHCl3 ( = 7.26 ppm) and tetramethylsilane (TMS,  = 0.00 ppm). 
Because the NMR instrument’s deuterium lock generally prevents the frequency from 
drifting, most spectra will already be extremely close to referenced. But just to make sure, 
move your cursor over the peak that you think to be CHCl3 or TMS, left-click, and pick the 
appropriate reference frequency from the list. (See next page.) 

 

 



 
4. Next, we’ll work on making the spectrum presentable. In order to put chemical shift labels on 

the peaks, click PeakPicking. If you then click Auto to have the computer pick peaks for 
you, it only does an okay job. To do a better job, zoom in on each area you want to pick 
peaks in, click Peak Level, and click your cursor at the height above which you want all 
peaks labeled. Or, choose Peak by Peak and click on peaks individually. If you don’t like 
what you’ve chosen, click the Clear button. If you do like what you’ve done, click the green 
check mark to go back to the main spectrum window. 

 
 Your 1H peak labels should show chemical shift to the fourth decimal place. If they don’t, 

choose Options → Preferences → Peaks and change the Numerical Display option. 
 
5. Click Integration to set up integration ranges. If you pick Auto, the computer will not 

integrate intelligently—it will split up or join multiplets, and make the ranges too broad or 
narrow. Instead, choose Manual, and then click and drag regions of the spectrum you want 
integrated. If you click and drag a region that you want to serve as a reference—say a peak 
you know to correspond to a methyl -CH3—then right after you set that integral, type an 
integral (3 in this case) in the Reference box. 

 
 If you don’t provide a reference value, occasionally the program will report integrals with too 

few significant digits. The default setting is to give values to the hundredths place, so you 
will occasionally see integrals with values “0.01” or even “0.00”. These values are clearly 
unreliable—0.01 could mean anything between 0.005 and 0.0149—but you can fix that 
problem by setting one of the integrals to a higher Reference value. 

 
6. Most of the time, steps 1-5 will be all you need to process your spectrum. At this point, you 

might File → Print in order to have a hard copy, or you might Edit → Copy to Clipboard 
so you can paste the spectrum into your lab report. 
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Lab 2 Appendix B 
Nonlinear Least-Squares Curve Fitting with Kaleidagraph 

 
 
If you would like to try to fit your (f, F) data directly to the copolymerization equation, you 
might use Synergy Kaleidagraph. (You can also do nonlinear least-squares fitting on Microcal 
Origin, Mathworks MATLAB, or Wolfram Mathematica, if you have access to them and know 
how to use them. It is also possible to use Excel’s “Solver” functionality to do nonlinear least-
squares fitting, but it is complicated, and I recommend against it.) Kaleidagraph is easy to use, 
but you will have to go to the Microcomputer Lab (101D Smith) to use it. 
 
To use Kaleidagraph for nonlinear least-squares fitting: 
 
1.  Open Kaleidagraph and click File, Import, Excel to import data from an Excel spreadsheet. 
 
2. Graph your data by clicking Gallery, Linear, Scatter. Pick the appropriate columns for the 

x- and y-axes, and create a New Plot. 
 
3. To fit any of your data to a custom function, click Curve Fit, General, fit1. (Fit1 is already 

defined, but we will change it. If you want to create and save functions rather than just 
editing the one in the program, click Curve Fit, General, Edit General and create new 
functions.) 

 
4. Check the data box you want to fit. Then, click Define to create your function. The function 

has to have a specific form in which the independent, x-axis variable (e.g., f) is named “m0” 
and all other variables to be optimized are named “m1”, “m2”, etc. The equation is then 
followed by initial guesses for the optimized variables. So, for example, if you were graphing 
(f, F) data and you wanted to fit it to the equation 
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 you might type 
 

(m1*(m0)^2 + m0*(1-m0))/(m1*(m0)^2 + 2*m0*(1-m0) + m2*(1-m0)^2); 
m1 = 1; m2 = 1 

 
 in the function box. In this equation, the “F1 =” part doesn’t show up, m0 stands for f1, m1 

for r1, and m2 for r2. You also need to input initial guesses at the end for m1 and m2; here 
I’ve guessed 1 for both. Importantly, none of your initial guesses can be set to a value of 0, or 
you will get an error. The program will turn your guesses into optimized, fit values for m1 
and m2. 

 



5. Click OK, and a fit curve should appear in your data window, along with the optimized 
values and other information from your fit. If you don’t like your fit, you can remove it from 
the graph by going back into Curve Fit, General, fit1 and deselecting the check box for the 
fitted data. Click OK, and the fit curve and fit data disappear. (This way, if you made a 
mistake in the equation, you can go back and re-fit onto the same data.) If you get a “Singular 
Coefficient Matrix” error during your fit, it is probably because your initial guesses were 
really far off; try new guess values. 


